
  

© 2014 Richard S. Ridings of Ridings Administrative Services Inc.  1 
Information subject to change without notice 

 

 

 

Revision: Jul 29, 2014 BMR Version 2.1.0.2 

BizMan Reports 2.0 – a Crystal Reports Viewer for Sage 50 

Step-By-Step 

 Thank you for your interest in BizMan Reports 2.0.  This document will take you through the 

setup and use of the program step-by-step.  If you experience any problems while using BizMan 

Reports 2.0, please initiate a technical support request by email only to ridings@ridings.ca.  The 

following document will refer to BizMan Reports 2.0 as either the program or BMR. 

 There are many options while using the program, so the attempt has been to include as many 

as possible.  If I have missed anything, please let me know.  Not all features you may wish to be in the 

program are included.  The program will be updated with new options as time permits and as requests 

come in. 

 The below information assumes you are running the program on a Windows 7 computer and 

already have BMR installed.  The installation completes with the option to start BMR right away.  

That’s where we start below. 

Please do not forget to read the Changes to Sage 50 section below – these settings must be done 

before you hit Print in Sage 50.  Please also see the section about Testing Before Upgrading. 

1) When you start BMR at the end of the installation process, the program will ask for a filename 

and probably show you the My Documents folder on your computer. 

 

2) When you start BMR any other time, it can be initiated from the icon on the desktop (if you 

chose to install one during installation), or from the BizMan Reports program group on the 

Start menu. 

 

3) If you have opened BMR before, the last folder/directory you selected a file from, will be 

displayed (see below).  If you wish a different file in a different location, either pick it from the 

list on the Filename field drop-down (if applicable) or navigate to the location and select it 

from the list using the tools in the dialog box for navigation as you do in other Windows 

programs. 
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4) Next you will see a log in dialog box (below).  You must enter the User Name and password 

that you use in your Sage 50 file.  If you do not use a User Name and Password, please enter 

sysadmin as the User Name and nothing in the Password box as in the image below.  Please 

remember the security rules.  Both User Name and Password are case-sensitive and if you 

think you have password longer than 7 characters, enter only the first 7. 

 

5) If this is the first time starting the program, you will be asked to set up some forms for 

automatic printing.  One of the benefits of this program is that it will automatically trigger the 

printing of your Custom Crystal Reports forms.  If you wish to have a custom Crystal Reports 

invoice print when you hit Print in Sage 50, then you need to set up at least an invoice form for 

automatic printing. 
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6) If this is not the first time starting the program and you wish to modify the forms information 

that automatically print, select the Report Setup button from the main Home screen menu in 

the image below. 

 

Note: Hold your mouse over any field, button, etc. in this program to see some help 

 

7) Once you are on the Forms Setup Information screen, you will have several options (see 

below).  If this is the first time you are using the program, the upper box where the labels 

Report Name and Report Type are located, will be blank.  Click New at the bottom. 

 

8) If you have used BMR before and you wish to change the settings on an existing report, select 

the Report from the box at the top and click Edit.   If you wish to add a new form to the list, 

click New. 

 

Note: clicking on a report already listed in the box will present the details of the options for 

that form in the boxes at the bottom of the form.  Once the information is visible, you can click 

the Edit button to change the information, select some other form, or Close to close the Forms 

Setup Information dialog. 

 

9) Once you have clicked on the New button, all the fields will be available to enter information 

or select options.  See the options below the image to learn how to fill them out. 

 

10) Assume you run the ABC Company, and you wish to print a customer invoice automatically 

when you print from Sage 50. 
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11) Select New and enter ABC Invoice in the Report Name field.  This name is anything you want 

that tells you what it is.  It is also used as part of the Direct To PDF filename if applicable. 

 

12) Select the type of form from the Form drop-down option.  Most of the main forms are listed.  

Please select Customer Invoice for this example. 

 

13) Select the Browse button to select the form to print (should have a name that ends with an rpt 

extension).  Users can also just type in the name in the Report Path box. 

 

Advanced Info: some forms ask the user for some information before printing.  With the 

upgrade in the print engine, it will no longer ask the proper questions when printing directly to 

the printer or exporting directly to a pdf file.  Therefore, these options are turned off if the 

chosen Crystal Report has one or more parameter prompts included in the programming.  

These options are programmed specifically for the company using them and not all forms use 

them.  After selecting a report or leaving the Report Path field, the report is checked to see if 

those parameters exist and if so, the user is warned and the options are turned off.  Users can 

preview the forms and then print or export once they see the invoice (or other form) on 

screen. 
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14) Once the check for parameters is completed, if there are none, users will have the options of 

deciding whether to Preview the form before printing, print directly to a particular printer or 

exporting directly to a pdf. 

 

Note: Printing Direct to Printer will not allow the user to see the form before being printed.  It 

currently prints only one copy.  Direct to pdf will send the report to a pdf at the location 

specified in the at location box.  Use the Select Location button to determine where it will be 

stored. 

 

Important: The filename for the pdf will be made up of the Report Name and the Form type.  

So in our example here it will be ABC_Invoice_Customer_Invoice.pdf.  Each time an invoice is 

printed, this pdf file is overwritten without notice. 

 

15) In this example, select Show Preview.  It will enable the user to see the form with it’s data on 

screen before printing.  See the completed image below. 

 

16) Hit Save to save the changes.  Note that the fields will now be emptied and will have a grey 

colour.  The form will be listed in the box at the top.  If you click on it, you will see the details in 

the fields again. 
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17) If the user wishes, once the report is selected at the top, the report settings can be edited and 

resaved, deleted, or the changes can be cancelled. 

 

18) Click Close to close the Forms Setup Information dialog. 

 

19) After you set the settings in Sage 50 from the section below, test by looking up an invoice and 

hitting Print to see what happens.  You should get an invoice on screen that you can then print 

or export to pdf or Excel. 

 

20) When printing from Sage 50, the Microsoft XPS Document Writer will ask the user for a 

filename because it’s job is to create an image file on the hard drive.  Select Cancel and select 

Ok when Sage 50 tells you printing was cancelled. 

 

21) By this time, if the csv files have been created or updated, the invoice should be showing up on 

screen (in our example we used the Show Preview option).  When it comes on screen, you 

have several options.  See the image below and the text below it for options (I know the 

company name should have been ABC Company but the Universl sample file was used for this 

document). 

 

22) The report viewer in the image above has several options.  The menu allows the user to see 

Report information on the Report menu, or open a new report on the File menu.  The Crystal 

Viewer toolbar will be explained below.  The Group Tree or Parameter panel are used if the 

report is designed to use them.  For example, if you have printed a customer statement and 

have your report showing the Group Tree, you may see your customer names there.  The 
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status bar indicates the date, file path and name you are reporting on, Crystal version used to 

create the report (Note: Crystal 8 and 8.5 report the same version) and the user name used to 

logged into BMR. 

 

23) Crystal Viewer Toolbar – From left to right: 

a. Export button – use this to export to pdf or various versions/formats of Excel.  There is 

no ability to select pages to create.  It always creates one pdf of all pages. 

b. Print button – use to print the information on screen.  Change printer, number of 

copies, select pages, etc. 

c. Refresh button – missing from the Sage 50 program.  If any information changes in the 

data, it can be refreshed to show it on the report. 

 

Note: this refresh button is not that useful with forms if they were created from the csv 

files, but very powerful when running reports similar to the method of the Microsoft 

Office Documents program in Sage 50 that were created based on the *.sai file.  Also 

allows the changing of parameter information if applicable. 

 

d. Copy button – sounds weird but it is a very useful tool.  Click on text or other 

information on the report, click the Copy button and then paste it to any other 

program.  Great for copying email addresses, customer full names, etc. 

e. Parameter Panel button – this is useful if the report was created in a more current 

version of Crystal Reports and makes use of the Editable Parameter option.  Users can 

edit the parameter information directly on screen and quickly refresh the data without 

waiting to pull it from the database again.  See the order form on the File menu of the 

main BMR menu for an example of this. 

f. Group Tree button – mentioned above, will allow the user to see all groups.  Click on a 

group and go immediately to the page where that group starts.  Print 1500 customer 

statements, scroll down through the customers until you want to click on one and end 

up on Page 238 without paging through all those pages. 

g. Page Navigation buttons – a series of four buttons for page navigation.  Go to start of 

report, Previous page, Next Page and go to the end of the report. 

h. Page Number box – Enter a page number and automatically go to it.  A quicker way to 

get to Page 238 if you know that is where you want to be. 

i. Search – Find any text or numbers you want.  A good reason to use the Copy button. 

j. Zoom – the zoom button to make the report bigger or smaller and fit the whole page 

on screen. 

 

24) The main BMR Menu also has an option for Open Report.  It will bring up the same viewer, just 

select a report (usually any file with the *.rpt extension) and follow the prompts until you get 

the viewer. 
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Advanced Info: In past versions of Sage 50, any report could be created on the live data in the 

*.sai file.  To run these reports, users did not have to own Crystal Reports.  The programmers 

of Sage 50 maintained the ability to run Crystal Reports in the Microsoft Office Documents 

program on the Reports menu.  This program, originally called Custom Reports in Simply 

Accounting version 9, allowed users to run a report, log into their proper database and view, 

print, export the information depending on the user’s needs.  The Open Report button in BMR 

does the same thing.   

 

25) The Open File button on the main BMR menu will allow users to change files for those who run 

multiple companies.  You must change files if any form or report expects data to come from 

the *.sai file directly. 

 

Advanced Info: For example, you wish to print a customer statement but also have the PO 

number or shipping address, or all line item details from the invoice show on the statement.  

Some of these reports are based on the csv files for the main statement but then the report 

must be programmed to pull the information from the correct file for the rest of the details.  

When running the report, BMR will point the details to be pulled from the Sage 50 company 

file you opened when you started the program.  This makes sure the program will get the 

correct information. 

 

26) The File menu on the main BMR menu allows the user to print the order form.  The order form 

will prompt the user for the number of computers to license and the province for sales tax 

purposes.  The user will then print, complete the rest of the form and fax it to the number on 

the form or email it to the address on the form.  The file menu also gives an option to install 

the license key that will be generated and sent by email to the company ordering the program. 

 

27) The Close All Reports option was created because, while testing the programming, reports 

were constantly left open and not closed.  Similar to the option in Sage 50, click this button 

and any report left open will be closed immediately. 

 

28) The Help menu will allow the user to see some detailed information about version, tech 

support email address, company file that is opened, etc.  The design of this screen will change 

and other information may be included.  Click anywhere in the open spaces or hit any key to 

close. 
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Changes to Sage 50 Settings 

1) In Sage 50 there is one setting that needs to be set for the company file as a whole, then for 

each form you print with BMR, it is recommended to change the printer driver to one that will 

not print to a real printer (to save paper). 

 

2) In Sage 50, log in as sysadmin in single-user mode.  Select Setup, Reports & Forms, Form Data 

Export.  Put a checkmark in the box for Export CSV Files as in the image above. 

 

Note: Since 1996 when Simply Accounting first support printing with Crystal Reports, all 

information sent to Crystal templates was done via csv files.  These are just text files that 

Crystal reads to present the data and design/programming requirements users need.  There 

have been few changes since then until Sage 50 2014.3 removed the capabilities.  One change 

in the latest version, 2014.3, however, the csv files are now removed from the computer on 

closing Sage 50. 

 

Advanced Info: Please note that there have been several reports that the checkbox in the 

image above does not stay checked.  We are still looking into why but the closest we have 

come is the subsidiary users lower than sysadmin, can end up turning off the checkbox by 

changing the printer driver for a form.  This has not been replicated in tests, but we have seen 

it happen on a computer we were working on.  We have not been able to replicate it in our 

office, nor has one other consultant that is testing. 



© 2014 Richard S. Ridings of Ridings Administrative Services Inc.  10 
Information subject to change without notice 

 

3) Each form-type in the above image, represented by the text at the left (eg. Invoices, Purchase 

Orders, etc.) have separate settings for each user.  So each user should log in and change the 

printer driver to something appropriate.  Remember, every time a user hits Print in Sage 50, a 

Sage 50 form will be sent to the printer.  If you wish to prevent the waste of paper, it is 

recommended to change the Printer to a driver that does not use paper.  The following 

instructions will assume you use the Microsoft XPS Document Writer as in the image below. 

 

4) Log into your Sage 50 company file as your normal user name.  Select Setup, Reports & Forms 

and then the form type you wish to make changes to.  In this example, we are changing the 

Invoice settings for ABC Company.  So in the above image, make sure the printer selects one 

that does not use paper.  We recommend to use the MS XPS Document Writer or a pdf creator 

driver. 

 

5) When printing from Sage 50, the Microsoft XPS Document Writer will ask the user for a 

filename because it’s job is to create an image file on the hard drive.  Select Cancel and select 

Ok when Sage 50 tells you printing was cancelled. 
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Testing with Sage 50 2014.2 Before Upgrading to Sage 50 2014.3 

1) There is no need to upgrade just to test.  The BMR program is compatible with Sage 50 

2014.2.  The settings are the same as you are currently running. 

 

2) Follow the above instructions for setting up BizMan Reports 2.0.  These settings will not 

change.  If you are unsure of where your forms are located, in Sage 50 select Setup, 

Reports & Forms and the form you wish to print using Crystal.  Look in the Form box under 

Printer Form settings.  In the above image it shows a Sage 50 form, not Crystal Reports 

form under Form Type but the Form box shows the name of the file and path that you are 

currently using on your own program. 

 

3) In Sage 50, the only change would be to change the printer driver so you do not waste 

paper while testing if you wish.  Follow the same instructions above for changing to the 

Microsoft XPS Document Writer driver.  During testing, some people have left the printer 

alone so while testing they get two pages from the printer to confirm both are identical.  

One comes from Sage 50 and the other (usually the second one), comes from BMR. 

 

4) Print an invoice in Sage 50 and see what comes out. 

 

 

Thank you for reviewing BizMan Reports 2.0!  If you like the program, please let us know by 

ordering as many licenses as you need.  You may not need licenses for all computers using 

Sage 50 because not all users will print using Crystal Reports templates.  See the Order form on 

the File menu in the program or from the website 

http://www.ridings.on.ca/download/bizmanorderform.pdf. 

 
Note: all programs mentioned, not belonging to Ridings Administrative Services Inc., belong to their respective companies and may be 

trademarked. 

http://www.ridings.on.ca/download/bizmanorderform.pdf

